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Lesson 1 - Navigation 
 

Objectives:  

1.1. Open TOPSpro Enterprise 
1.2. Explore the menus and submenus 
1.3. Understand TE record type 
1.4. Explore the relationships of records and database hierarchy 

 
 
 

 
 
 

1.1. Open TOPSpro Enterprise 
 

1.1.1. Start the program by double-clicking on the TOPSpro Enterprise icon located on 
the computer desktop. 
 
 
 
 
 

1.1.2. If you do not have an icon on your screen, you may need to access the Web to 
download TE: 
 
1. Go to https://etestsonline.org 
 
2. Click TE Client in the upper left. Wait for it to install. 
 
3. Login using the following credentials: 
 
    Server: eTests Simulation – www.etestsonline.org/RollingHills 
    Agency: 4908 
    User: coordinator1@rhas.org 
    Password: coordinator (all lower case) 
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1.1.3. Login using the credentials below. The facilitator will provide you with a specific 
User profile. 

 
                  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1.4. Click Connect or press ENTER on the keyboard. 
 
 

1.2. Navigate the menus, submenus, and icon bar 
 

TOPSpro Enterprise uses a similar type of menu system that you see in most Windows-
based applications. Look at the menu bar.    

1) The left side of the bar shows the menu 
bar options. In TOPSpro Enterprise these 
are TE, View, Organization, Records, 
Reports, Tools, and Help.  

2) To the right is the title bar. It displays your Username and the version of Enterprise 
that you are using, and other options to adjust your screen size. 

 

 



      

4 ©CASAS 2013

 

Now let’s take a look at some of the menu features. Do not worry about figuring out any of these 
functions yet. All you need to do is point to the features on the menu so you can see how 
TOPSpro Enterprise organizes its menu. 

1.2.1. Find the TE Menu icon and click once. Highlight each menu option. 

 

 
 

1.2.2. On the View menu, point to Medium. Note the change in font 
size on the menus.   

 

 

 

1.2.3. On the Organization menu, point to Classes, and select Definitons. 
 

1.2.4. On the Records menu, point to Programs, and select Enrollments.. 
 
1.2.5. On the Tools menu, select TE Import/Export Wizard. 
 
1.2.6. On the Reports menu, point to Demographics, and point to Demographic 

Record Summary.    

 

 

1.2.7. On the Help menu, point to Contents. 



                                                                                                                     

© CASAS 2013 5 
 

 

EXERCISE 1.1 
 

1.  Where do you go to launch TOPSpro Enterprise? 
 

2.  How would you change the Display to a larger font size? 

 

3.  How would you open the Learning Gains Summary report? 

 

4.  Where would you import data from a third party system? 
 

5.  What is the difference between the Tests Lister and the Assessments Lister? 
 

1.3. Explore the relationships of records and the database hierarchy 
 

1.3.1. On the Organization menu, click Agencies. 
 
 
 
 
 
 
 
 
 
 

1.3.2. Locate the Refresh button, which directs TOPSpro Enterprise to display an 
updated listing of your data. 

 

 
1.3.3. At the top of the TOPSpro Enterprise reporting hierarchy is the Agency. Place the 

cursor on top of the Agency Name that is highlighted in blue. Double-click the 
agency name with the left-mouse button. 
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1.3.4. A new dialog box containing agency 

information will open. View the Navigator 
section of this window to the left. Edit/View 
is highlighted indicating that the data 
appearing in the dialog box about this 
agency is editable. 
 

 

1.3.5. Click Sites. Each Agency in Enterprise contains one or more Sites. Sites can be 
a physical location or a cluster of locations within the agency.                         
 
Double-
click the 
first site, 
Site #1, 
North 
Campus.   

 

1.3.6. The Site Information dialog box should open. 
 

1.3.7. Once again, the Navigator bar opens to 
Edit/View, and displays the basic information 
about this site.  
 
 
 
 
 

1.3.8. Click Classes definitions. Each Site contains one or more Classes.  

 

1.3.9. Place the mouse on top of 
the first class on the list, 
Class #1, ABE. Double-
click the record. 

 
1.3.10. The Class definition Info 

dialog box opens with 
again, the Navigator bar on 
Edit/View.  
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1.3.11. Click Class Instances. This displays a record 
with more detailed information about that 
class.  
 
 
 
 
 

1.3.12. Double-click anywhere on the row to open the record listed. 
 

1.3.13. Once again, this record includes a 
Navigator bar that includes different 
selections related to the record that you 
opened. 
 
 

1.3.14. Click Class Enrollments.. This displays an unduplicated list of students 
assigned to this class. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.3.15. Click Class Records. This displays a duplicated list of students in the class, with 
a separate record created each time new information is updated for that student. 
 

1.3.16. Click Tests to view the tests that have been administered in this class.  
 
1.3.17. On the right hand side of the screen, find the Pages tab to open a new menu. On 

the Pages menu, select Close all Pages to clear your screen.  
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Congratulations! 

You have successfully navigated throughout TOPSpro Enterprise. 

 

EXERCISE 1.2 

1.  What is the Agency number for Rolling Hills Adult School?    

2.  How many Sites are included in Rolling Hills Adult School?    

3.  How many Classes are included in Site 2, South Campus?    

4.  How many Students are enrolled in the North Campus Class 1, ABE?  

5.  How many total records are there in Class 1 ABE when you click Class 
Records?   

 

6.  Who is the first Student listed in the North Campus ESL morning class? 

 

7.  Which Class has a higher enrollment – 424 ESL morning, or 432 ESL high?   

 

8.  How many Students are assigned to Site 2 – South Campus?  
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2. Verifying & Editing Data  
 

Objectives: 

2.1. Use TE listers to find records 
2.2. Explore and Edit Student Records 

 
 
 
 
 
 

2.1. Use the TE Listers to find records 
 

There are several selections included in the Organization and Records menus. These are 
the two menus in TE that include listers.  

The Organization menu includes listers that pertain to the agency’s organizational  
structure--featuring “container” records such as agency-site-class, features that help 
manage database security, and staffing related records.  

The Records menu includes listers that contain more detailed student level information, 
such as student demographics, and specific fields that link a student with a class or 
program.  

Each name in this menu indicates the specific information that it contains. For example, the 
selection under Organizations – Sites is the table that contains site records. If you go to 
Records – Tests that is the table that contains a list of tests. 

 

2.1.1. On the Records menu, point to Students, and then click In Program Years.    
 
 
 
 
 
 
 
 
 
 

2.1.2. The Student In Program Years Lister will open.   
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2.1.3. Click the Refresh button   or Refresh icon.  
 

2.1.4. You can also set the application to auto-refresh buy going to the TE menu and 
selecting Options. (The training dataset is already set to this feature.) 

 
The contents of the Lister will then appear. Each row that you see represents an individual 
record. You can single-click anywhere on the row of the record to highlight it. Double-click 
anywhere on that row to open, view, or edit a record. 

 
 

2.1.5. Notice the action buttons on the lister toolbar at the top of your screen.   
       

 
      

2.1.6. Locate additional buttons by clicking the More button to the right of the other 
action buttons. 
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2.1.7. You can quickly view the number of students in the lister by looking at the figure 
at the top.  
 
 
In this example, there are 337 records in the Lister, and the one highlighted 
listing is the first record in the list (Isabel Martinez). 

 
2.1.8. You can limit your Lister 

display to a particular Site by 
using the Site filter box. Click 
the arrow to the right of the 
Agency/Site filter box. A 
drop-box will open. Click Site 
2, South Campus. Refresh. 

  
This will limit your list of 
students to only those 
attending that Site. 

 
2.1.9. Use the same Agency/Site 

filter box to restore the list 
back to Agency 4908. 
 

2.1.10. Use the Filter, Columns, and Sort buttons to organize the display of your lister. 
 

 
 

 Filter allows you to limit your lister display only records that meet 
specific criteria that you select. 
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 Columns enables you to select and de-select which columns will display 
in your lister. 

 
 

 Sort is where you designate which field determines the display order of 
your lister, for example the screen shot below shows a lister sorted 
numerically by Student ID. 
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TOPSpro Enterprise also provides users with simple options to quickly retrieve information, 
and to customize listers to display preferred fields.  

 
 

2.1.11. On the Records menu, point to 
Students, and then click 
Demographics. 

 
2.1.12. Right click on the column header for 

Races.  
 
2.1.13. Performing this enables you to hide 

the column you selected or add 
additional fields. Click Hide Races 
to remove this column. 

 
2.1.14. Repeat the steps by right-clicking 

Ethnicity and also removing that 
column from the lister. 

 
 

 

2.1.15. Now, we want to add a new column instead of subtracting an existing one. Right-
click the grey space to the right of the lister columns. This generates a list of 
columns that you can add. Select Show Age.  
 

2.1.16. On the Gender column, click the Add Filter 
icon to open the filter box for that column. 
Check Female.  

 
 
 
 
 
 

2.1.17.  Click the same icon in the Age column, and type in the age range of 33 to 43, 
as in the graphic below. Click OK.  
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2.1.18. Click Refresh.  

 
2.1.19. You now have a filtered list of all female students from the age of 33 to 43.  

 
2.1.20. Click the Add Sort icon in the Age column. This arranges the list 

in order from age 33 to 43. Clicking a second arranges it in 
reverse—from 43 to 33.  

 
2.1.21. Click the red “X” in both the Age and Gender columns to restore 

back to the full list of students.  

 

EXERCISE 2.1 

1.  How many Current Students are there in Rolling Hills Adult School?  

2.  How many Current Students are there in Site 11 North City ESL?  

3.  What is the Student ID for Marlon Sneed?  

4.  Which Student is assigned ID 599661101?  

5.  Which Student in Site 11 North City ESL has the earliest Date of Birth? 

     

6.  How many Female Students are there in the program year at Rolling 
Hills between the ages of 23 and 29? 

 

7.  How many students enrolled in Site 2, South Campus with native 
language of Spanish? 
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2.2 Explore and edit student records  
 

The Student record is the "parent" record for all other learner-related records, such as the 
Entry, Test, and Update records (which are all “child” records.) The foundation for the Student 
record is the Student Identification (ID) number, which provides the common element that 
links all of the records assigned to the student, and supplies the minimum information Enterprise 
needs to create a Student record. 

 

2.2.1 On the Records menu, point to Students, and then click Demographics, Click 
Refresh. 

 
 

2.2.2 Find the record for the student Acuna, Rosalina, by clicking the Filter icon in the 
Name field and searching for Acuna. (Note: be careful how you set up this filter.) 

 
 

2.2.3 Open the record for Rosalina Acuna by double-clicking anywhere on the row of 
that record. 
 
 

 

2.2.4 The Student Info dialog box should open. 
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2.2.5 View the Navigator section of this window 
on the left-hand side. It opens to Edit/View, 
which enables you to edit and view 
Rosalina’s personal student demographics 
information. Edit/View contains the “parent 
record” data for the student record, while 
the other selections on the Navigator bar 
represent “child records.” 

 

2.2.6 Clicking the different options on the 
Navigator panel provides views of a variety 
of information about that student. 
 

 
 

2.2.7 In Program Years displays 
the years in which Rosalina has 
dated activity in the database. 
 

 
 
 
 
 
 
 
 

2.2.8 Student Records displays a list of all of the dated activity that occurred for 
Rosalina during the year.  
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2.2.9 Class Enrollments lists each class in which the student is enrolled. This list will only 
include one listing for each class. 
 

 
 

2.2.10 Class Records shows all class related activity for the student. This section includes 
separate records for all data activity related to the class. 
 

 
 

2.2.11 Program Enrollments lists each program in which the student is enrolled. This section 
will only include one listing for each program. 
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2.2.12 Program Records shows all program related activity for the student. This includes 
separate records for all data activity related to the program. 
 

 
 

2.2.13 Tests displays Rosalina’s tests. 
 

 
 

2.2.14  Return to Edit/View. 
 

2.2.15 Click the Edit icon. This opens the Edit/View screen for editing. 
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2.2.16 In Identification, find the Date of Birth field. 
 

2.2.17 Change Rosalina’s date of birth from 5/9/1987 to 5/9/1982. 
 

 
 

2.2.18 Click Save.  
 

EXERCISE 2.2 

1.  What is Rosalina Acuna’s Date of Birth?    

2.  What is Rosalina’s Native Language?    

3.  How many Test records does Rosalina have for PY 2012-13?    

4.  What is Rosalina’s Secondary Attainable Goal?    

5.  What is the Highest Year of School Completed for John W. Bestway? 
 

6.  On what date was John’s first Update completed?   
 

7.  How many different programs is Chuckie Garcia enrolled for 2012-13? 
How many classes? 

 

  
 

Congratulations! 

You have successfully explored, edited, and designed student records in 
TOPSpro Enterprise. 



      

20 ©CASAS 2013

 

3. Manual Data Entry 
 

 

Objectives:  

3.1 Enter Student Demographics 
3.2 Create a Class and a Teacher 

 
 

 
 
 

3.1. Enter Student Demographics 

3.1.1 On the Records menu, point to Students, and select Demographics. Click 
Refresh. 
 

3.1.2 Click the New icon. 
 
 

 
 

3.1.3 Enter information for the new student as it appears in the graphic on the 
next page.  

 
3.1.4 When finished, click Save.  

 
3.1.5 Return to the Student Demographics lister.  

 
3.1.6 Click the Add Filter icon in the Student code column and type in the 

Student ID 555778989. Click Refresh. 
 
 
 
 
 
 
 
 
 
 

3.1.7 The new student demographics record for Elvin Miles should now appear. 
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3.2. Create a Class and Assign a Teacher 

3.2.1 On the Organization menu, click Sites. Click Refresh. 
 

3.2.2 Open the record for Site 11 – North City ESL. 
 

3.2.3 On the Navigator bar, click Class Definitions. 

  

3.2.4 Click the New icon.    
 

3.2.5 Enter information for a new Class 113 using the data in the graphic below. 
 
 
 
 
 
 
 

 
 

 

 

3.2.6 Click Save. Notice that additional selections appear on the Navigator bar. 
 

3.2.7 On the Navigator bar, click Class Instances. 
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3.2.8 Click the (lower) New icon. 
 

3.2.9 Enter the information using the graphic on the next page. 
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3.2.10 Click Save. Again, new selections appear on the Navigator bar. 

Now we will add a couple of students and a teacher to this new class. 

3.2.11 On the Navigator bar, click Class Enrollments. 
 

3.2.12 Click New.  
 

3.2.13 Open the Student drop box.  
 

         

3.2.14 Select students David Vega and Lena Lukashuk and add them to this class. 
 

3.2.15 Return to the Class Instance Record and click Class Enrollments. Note 
that these two students now appear in this lister. 

 
 
 
 
 
 

 
 

3.2.16 Click the open tab for the class definition record you originally created for 
Class 113. 
 

3.2.17 On the Navigator bar, click Teachers. 
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3.2.18 Click the (lower) New icon.  
 

3.2.19 Enter new teacher information based on the graphic below.  
 

 

 
3.2.20 Click Save.  

 
3.2.21 On the Pages tab, click Close All Pages. 
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4. Scanning 
 
 

Objectives:  

4.1 Scan New Records in TE 
4.2 Edit and Verify Scanned Data in TE  

 
 
 
 
 
 
 
4.1 Scan new records in TE 

4.1.1 On the Tools menu, select Scanning Wizard.  
 

4.1.2 (If applicable) Select New Scanning Session and then click Next.  
 

 
 

4.1.3 Check Simulate Scanning. Click Next. 
 

 
 

4.1.4  Select Entry for the Front Side, and for Back Side, select None. 
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4.1.5 Click Scan. 
 

4.1.6 In the Windows dialog box, find the Entry Record simscan file to simulate 
scanning. Click Open. (Note: your file will differ from the graphic below. The 
facilitator will provide you more instructions on this step.) 

 

 
 

4.1.7 Click OK, and then click Next.  
 

4.1.8 Check Select field overrides and then click Next.  
 

 
 
4.1.9 In Front Overrides input the following information below.  

 

 
 

4.1.10 Verify the additional settings on the next screen and click Next.  
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4.1.11 The next screen includes the “batch repair” options, where you can edit the 

records that you scanned. 
 

 
 
 
For this exercise, we will assume everyone in this batch is instructional program = 
ABE, with a scan date of 9/4/2013. 
 
 
4.1.12 Use the Ctrl key to highlight the four records that currently indicate 

Instructional Program = ESL, as shown in the graphic below. 
 

 
 
4.1.13 Click Edit Records.  
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4.1.14 In the the Data Correction Edit Window, select Instructional Program = 
ABE and Primary Goal = Improve basic skills. Click Save 
 
 
 
 
 
 
 
 
 
 
 

4.1.15 The batch repair table now displays your corrections. 
 

 
 

4.1.16 For the next edit, use the Ctrl or Shift key to highlight all ten records.  Click 
Edit Records. 
 

4.1.17 Find Entry Date, and select 9/4/2012. Click Save. 
 

 
 

4.1.18 The batch repair table now displays Entry Date as 9/4/2012 for all ten 
records.  
 

 
 
 



      

30 ©CASAS 2013

 

       
4.2 Edit and Verify Scanned records in TE 

The next step displays the list of the records you just scanned. Here is where we can “batch 
repair” the records we created during our scan session, and also add the name(s) for the 
students we entered. 
 

4.2.1 Select a record for editing and then double-click that record, or click Edit 
Records. This opens the Data Correction Edit Window.  
 

4.2.2 Edit the record like the example in the graphic below. (Note: your example 
may differ from the data represented in the graphic. Your instructor will 
provide more directions if necessary.) 

 

 
 

4.2.3 Click Save. 
 

4.2.4 On the Scan Wizard, click Next. 
 

4.2.5 Click Next to import the record(s) into TE. 
 

4.2.6 Click Finish. 
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5. TE User Accounts 
 
 

Objectives:  

5.1   Create a New User in TE 
  
 
 

 
 
 
 
 
 

5.1 Create a new user in TOPS Enterprise 

5.1.1 On the Organization menu, select Users. Click Refresh.  
 

5.1.2 Click New.  
 

5.1.3 Create the new user according the graphic below. For the password, select 
[all lower case] coordinator. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.4 Under Menu Access Rights, check all boxes to give this new user access 
to all TE menus.  
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5.1.5 Under Data Access Rights, check the boxes in the List Records and View 
Record columns to provide the new user with those capabilities. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.6 Click Save. 
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6. Generating Reports 
 

 

Objectives:  

6.1  Locate reports using the TOPSpro Enterprise menu 
6.2 Generate reports using the New Report Setup window 
6.3 Display, print, and navigate throughout TOPSpro 

Enterprise reports 
6.4 Use dynamic “drill down” features in TE reports 
6.5 Filter TE reports using Report Viewer Navigator 

 
 

 
 

 

6.1 Locate reports using the TOPSpro Enterprise menu 

 
6.1.1. Click the Reports drop-down menu. 

 

 

As you can see, there are several submenus or categories of reports in TOPSpro Enterprise. 
Each submenu includes reports that all relate to similar topic. By scrolling to each category, you 
can find out which reports that specific section contains. More reports will be added to 
Enterprise in future development. 
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6.2 Generate reports using the report setup window 

6.1.2. On the Reports menu, point to Demographic Reports, and then click 
Demographic Summary.  

 
 

6.1.3. The Report Setup window will open. This opens whenever you select any report 
in Enterprise. In this window you determine what specific information will appear 
in the report.  

 

A B 

C

D

E 
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A. Report Setup Navigator enables the user to filter the report using a variety 
of criteria, such as by specific student or class. Selections on the Navigator 
panel vary depending on the content of the report. 

B. Along the top of the window are icon or text buttons to complete basic 
commands, such as Save, Generate, and Print. 

C. Program Years and Date Ranges is where you indicate the record dates for 
the report. For example, in the setup window above, the report will include 
data from the current program year. Program Years enables you to select a 
specific fiscal year range, while Date Ranges enables a more detailed range 
of dates. 

D. Output Layout Parameters includes other selections that give you flexibility 
to customize the output of your report. This section has features such as 
Report Sort Order, Page Sort Order, and Print Options enabling the 
display either numerically by Student ID or alphabetically by Name. Some of 
these options vary according to the specific report you generate. 

E. Special Options varies from report to report, and is where you can assign 
specific conditions to that report generation, such as breaking on class or 
program, or showing the students’ complete test history. 

 
 
 
For this exercise, we will start by simply generating the report with no modificaitons to the 
setup.  
 
We do this by clicking the Generate button or icon. 

6.1.4. Click the Generate button. This opens the 

Demographic Summary report. You can scroll up  and down , and across   
to view the report. We will explore this and other reports further in the next 
Lesson.  
 
 

 

6.1.5. To enhance your view of the report, click 
the Unpin icon to minimize the Report 
Viewer Navigator. 
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6.3 Display, print, and navigate throughout Enterprise reports  

 
6.1.6. Refer to the report you generated. If you need to re-open it, from the Reports   

menu, point to Demographic Reports, and then click Demographic Summary. 
 

6.1.7. Click the Generate button. The report will open. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6.1.8. There are a variety of icons that run across the top of the report that enable you 

to perform certain functions. To the left are buttons that appear like this: 

 

A. Keep Session allows you to save the report so you can open the report in 
the TE Reports Manager at another time with the exact setup modifications 
you selected in the setup window.  

B. Delete Session closes the report and the setup window. Selecting this option 
means you cannot access this setup again using TE Reports Manager. 

C. Export enables you to save the report in different file formats so you can 
view the data in other programs. Most TE reports allow export to Word, Excel, 
Adobe PDF, and Rich Text Format. 

D. To print a hard copy of the report, click the Print icon.  

E. The navigation buttons allow you to go to a particular page within the report. 
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6.1.9. To the right are these additional buttons: 
 

 

A. Thumbnails allow you to view all of the pages included in the report in 
thumbnail format.  
 

B. Fit Page, Fit Width, and Two pages adjust the view of the report in different 
ways. 
 

C. Show All Summaries highlights the areas on the report that display 
aggregated entities and totals – that is, the data elements on the report on 
which you can “drill down.” 
 

D. Layout Settings enables you to make changes to fields in the setup window 
without having to close the report.  

 
6.1.10. Now we will regenerate this report. Click Layout Settings.  

 
 
 

6.1.11. In Chart Type, select the pie chart icon; in Pie Chart Descriptors, select 
Labels, and then click Apply.  

 

 
 

 

6.1.12. The report now displays in both table and pie chart format, with labels to denote 
each demographics category. 
 

6.1.13. Close the Demographic Summary report and the report setup window. 
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6.4 Use dynamic “drill down” features in TE Reports  

 
6.4.1. On the Reports menu, point to Data Management submenu, and select Data 

Integrity. 
 

6.4.2. Leave the settings as is in the setup window, and click Generate. 
 

6.4.3. Click the Unpin icon to provide a full view of the report. 
 
 

6.4.4. View all of the figures displayed on this report. Hover with your cursor over one of 
the figures to highlight the number, as shown in the graphic (below). 

 

 

 
6.4.5. Click the figure on the report that you highlighted. A new Lister appears, that 

displays a list of the learners included in that number. In this example, clicking 
the number “331” on the report generates a list of the 331  learners eligible for 
WIA Title II. 
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6.4.6. Double-click the top record on the list (in this example, Isabel Martinez) to open 
that student record. 
 

6.4.7. This directs you to that learner’s record so you can immediately view and/or 
correct the issue displayed on the Data Integrity Report. 

 
6.4.8. Note the orange bar that now appears. This signals that you have drilled down to 

a specific subset of data included in the report. (Note: clicking the red “X” to the 
right of the orange bar removes the drill down filter you selected, but will not 
return to the full report.) 

 
 
 

 
6.4.9. Click the report title at the top of the Navigator panel to return to the full report. 

 

 
 

6.4.10. The other selections in Report Viewer Navigator will direct to different TE listers 
that provide a variety of views that relate to the data cell on which you drilled 
down.  

 Generally, Students – In Program Years is the option to select if you want to 
ensure that the item count in the lister matches the items count displayed in 
the report cell. 

 The other selections below Students – In Program Years provide more 
detailed views to facilitate editing and correction of data. 
 

6.4.11. Click Students – Records. Note the item count for this lister is much larger than 
Students – In Program Years, as it includes a duplicated list of students. 
 

6.4.12. Open the top listed record (for this exercise, it should be Sofia Fraticelli.) This 
takes you directly to the student’s data, where you can add or correct the fields 
listed “on the spot.” 

 
6.4.13. Close the student record, and close the Data Integrity Report, but leave the setup 

window open. 
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6.4.14. In Report Setup Navigator, click In Program Years.  
 

 
 

6.4.15. This generates a list of all students in the selected program year who qualify for 
this report. Note that the item count is the same as for the total number of WIA II 
learners we reviewed in the previous exercise. 
 

 
6.4.16. In the Lister, use the column filters to 

replicate the same filter we performed in 
Lesson 2 – in Age, filter for students only 
between the ages of 33 and 43, and in 
Gender, select Female.  
 
 

6.4.17. On the top row, click Generate. The report now displays data integrity results for 
the filter we directed – for only female students between the ages of 33 and 43. 
 

 

6.4.18. Close all tabs 
 

Congratulations! 

You have created and interpreted reports and evaluated                                        

TE report selection criteria. 
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EXERCISE 6.1 

1. List at least three students who appear on the Data Integrity report under Item #2 – Less 
than 12 hours of instruction: 
 
--------------------------------------------------------------------------------------------------------------- 
 
---------------------------------------------------------------------------------------------------------------- 
 
---------------------------------------------------------------------------------------------------------------- 
 
 

2. What percentage of Rolling Hills WIA II learners have a conservative estimate pretest 
score? 
________________________________________________________________________ 
 

3. How many students at Rolling Hills have a Native Language of Spanish? 
 
_____________________________________________ 
 

4. According to the database, are there more students at Rolling Hills who are Employed or 
Unemployed?  ____________________________ 

       What are at least two reports available that can display this information? 

        ________________________________________________ 

        ________________________________________________ 

 

 

 

 

 

 


